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Copyright, trademarks, and disclaimer

Copyright © 2019 Milestone Systems A/S

Trademarks
XProtect is a registered trademark of Milestone Systems A/S.

Microsoft and Windows are registered trademarks of Microsoft Corporation. App Store is a service mark of Apple
Inc. Android is a trademark of Google Inc.

All other trademarks mentioned in this document are trademarks of their respective owners.

Disclaimer
This text is intended for general information purposes only, and due care has been taken in its preparation.

Any risk arising from the use of this information rests with the recipient, and nothing herein should be construed
as constituting any kind of warranty.

Milestone Systems A/S reserves the right to make adjustments without prior notification.

All names of people and organizations used in the examples in this text are fictitious. Any resemblance to any
actual organization or person, living or dead, is purely coincidental and unintended.

This product may make use of third-party software for which specific terms and conditions may apply. When that
is the case, you can find more information in the file 3rd_party_software_terms_and_conditions.txt located in your
Milestone system installation folder.
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About this guide

This guide gives you an introduction to encryption and certificates, together with step by step procedures on how

to install certificates in a Windows Workgroup environment.

Milestone recommends that you establish a Public Key Infrastructure (PKI) for creating and

distributing certificates. In a Windows domain, it is recommended to establish a PKI using

the Active Directory Certificate Services (AD CS).

If you are unable to build such a PKI, either due to having different domains without trust
A between them or due to not using domains at all - it is possible to manually create and

distribute certificates.
WARNING: Creating and distributing certificates manually is NOT recommended as a secure

way of distributing certificates. If you choose manual distribution, you are responsible for

keeping the private certificates secure at all times. When you keep the private certificates

secure, the client computers that trust the certificates are less vulnerable to attacks.

XProtect systems support secure communication:

From

Recording server

Management server

Clients, servers, and
integrations that retrieve
data streams from the
recording server

Mobile devices

To

Management
server

Recording
server

Recording
server

Mobile
server

When do | need to install certificates?

For more information

Management server encryption (explained) on
page 9

Encryption from the management server to
the recording server (explained) on page 10

Encryption to clients and servers that retrieve
data from the recording server (explained) on
page 12

Mobile server data encryption (explained) on
page 14

« If your XProtect VMS system is set up in a Windows Workgroup environment

« Before you install or upgrade to XProtect VMS 2019 R1 or newer, if you want to enable encryption during

the installation

« Before you enable encryption, if you installed XProtect VMS 2019 R1 or newer without encryption

« Whenyou renew or replace certificates due to expiry

In the following sections, read about:
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« Introduction to certificates on page 6

« Create CA certificate on page 16

« Install certificates on the clients on page 17
« Create SSL certificate on page 24

« Import SSL certificate on page 26

« Enable encryption on page 34

« View encryption status to clients on page 41
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Introduction to certificates

Hypertext Transfer Protocol Secure (HTTPS) is an extension of the Hypertext Transfer Protocol (HTTP) for secure
communication over a computer network. In HTTPS, the communication protocol is encrypted using Transport
Layer Security (TLS), or its predecessor, Secure Sockets Layer (SSL).

In XProtect VMS, the secure communication is encrypted using SSL/TLS with asymmetric encryption (RSA).
SSL/TLS uses a pair of keys—one private, one public—to authenticate, secure, and manage secure connections.

A certificate authority (CA) can issue certificates to the servers using a CA certificate. This certificate contains two
keys, a private key and public key. The public key is installed on the clients by installing a public certificate. The
private key is used for signing SSL certificates that must be installed on the server. Whenever a client calls the
server, the server sends the SSL certificate, including the public key, to the client. The client can validate the SSL
certificate using the already installed public CA certificate. The client and the server can now use the public and
private SSL certificate to exchange a secret key and thereby establish a secure SSL/TLS connection.

For more information about TLS: https://en.wikipedia.org/wiki/Transport_Layer_Security
In XProtect VMS, the following locations are where you can enable SSL/TLS encryption:
« Inthe communication between the management server and the recording servers

« Onthe recording server in the communication with clients, servers and integrations that retrieve data
streams from the recording server

« Inthe communication from clients to the mobile server
In this guide, the following are referred to as clients:
« XProtect Smart Client
« Management Client
« Management Server (for System Monitor and for images and AVI video clips in email notifications)
« XProtect Mobile Server
« XProtect Event Server
« XProtect LPR
« ONVIF Bridge
o XProtect DLNA Server
« Sites that retrieve data streams from the recording server through Milestone Interconnect

« Some third-party MIP SDK integrations
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For solutions built with MIP SDK 2018 R3 or earlier that access recording servers: If the

A integrations are made using MIP SDK libraries, they need to be rebuilt with MIP SDK 2019
R1; if the integrations communicate directly with the Recording Server APIs without using
MIP SDK libraries, the integrators must add HTTPS support themselves.

Certificate distribution

The graphic illustrates the basic concept of how certificates are signed, trusted, and distributed in XProtect VMS.

© A CA certificate acts as a trusted third-party, trusted by both the subject/owner (server) and by the party that
verifies the certificate (all clients) (see Create CA certificate on page 16)

© The CA certificate must be trusted on all clients. In this way the clients can verify the validity of the certificates

issued by the CA (see Install certificates on the clients on page 17)

'B The CA certificate is used to establish secure connection between the servers and clients and services (see
Create SSL certificate on page 24)

O The created private SSL certificates must be imported to the Windows Certificate Store on all servers (see
Import SSL certificate on page 26)

Requirements for the private SSL certificate:

« The server's host name must be included in the certificate, either as subject (owner) or in the list of DNS
names that the certificate is issued to

« The certificate must be trusted on all devices that are running services that retrieve data streams from the
servers

« The service account that runs the server must have access to the private key of the CA certificate
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Certificates have an expiry date. XProtect VMS will not warn you when a certificate is about
to expire. If a certificate expires, the clients will no longer trust the server with the expired

A certificate and thus cannot communicate with it.
To renew the certificates, follow the steps in this guide as you did when you created

certificates.
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Secure communication (explained)

Hypertext Transfer Protocol Secure (HTTPS) is an extension of the Hypertext Transfer Protocol (HTTP) for secure
communication over a computer network. In HTTPS, the communication protocol is encrypted using Transport
Layer Security (TLS), or its predecessor, Secure Sockets Layer (SSL).

In XProtect VMS, the secure communication is obtained by using SSL/TLS with asymmetric encryption (RSA).
SSL/TLS uses a pair of keys—one private, one public—to authenticate, secure, and manage secure connections.

A certificate authority (CA) can issue certificates to web services on servers using a CA certificate. This certificate
contains two keys, a private key and public key. The public key is installed on the clients of a web service (service
clients) by installing a public certificate. The private key is used for signing SSL certificates that must be installed on
the server. Whenever a service client calls the web service, the web service sends the SSL certificate, including
the public key, to the client. The service client can validate the SSL certificate using the already installed public CA
certificate. The client and the server can now use the public and private SSL certificate to exchange a secret key
and thereby establish a secure SSL/TLS connection.

For more information about TLS: https://en.wikipedia.org/wiki/Transport_Layer_Security

Certificates have an expiry date. XProtect VMS will not warn you when a certificate is about

to expire. If a certificate expires:

- The clients will no longer trust the recording server with the expired certificate and thus

cannot communicate with it.

- The recording servers will no longer trust the management server with the expired
A certificate and thus cannot communicate with it.

- The mobile devices will no longer trust the mobile server with the expired certificate and

thus cannot communicate with it.

To renew the certificates, follow the steps in this guide as you did when you created
certificates.

Management server encryption (explained)

You can encrypt the two-way connection between the management server and the recording server. When you
enable encryption on the management server, it applies to connections from all the recording servers that
connect to the management server. If you enable encryption on the management server, you must also enable
encryption on all of the recording servers. Before you enable encryption, you must install security certificates on
the management server and all recording servers.

Certificate distribution for management servers

The graphic illustrates the basic concept of how certificates are signed, trusted, and distributed in XProtect VMS to
secure the communication to the management server.
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© A CA certificate acts as a trusted third party, trusted by both the subject/owner (management server) and by the
party that verifies the certificate (recording servers)

© The CA certificate must be trusted on all recording servers. In this way the recording servers can verify the
validity of the certificates issued by the CA

© The CA certificate is used to establish secure connection between the management server and the recording
servers

O The CA certificate must be installed on the computer on which the management server is running
Requirements for the private management server certificate:

« Issued to the management server so that the management server's host name is included in the
certificate, either as subject (owner) or in the list of DNS names that the certificate is issued to

« Trusted on the management server itself, by trusting the CA certificate that was used to issue the
management server certificate

« Trusted on all recording servers connected to the management server, by trusting the CA certificate that
was used to issue the management server certificate

Encryption from the management server to the recording server
(explained)

You can encrypt the two-way connection between the management server and the recording server. When you
enable encryption on the management server, it applies to connections from all the recording servers that
connect to the management server. Encryption of this communication must follow the encryption setting on the
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management server. So, if management server encryption is enabled, this must also be enabled on the recording
servers, and vice-versa. Before you enable encryption, you must install security certificates on the management
server and all recording servers, including failover recording servers,

Certificate distribution

The graphic illustrates the basic concept of how certificates are signed, trusted, and distributed in XProtect VMS to
secure the communication from the management server.

© A CA certificate acts as a trusted third party, trusted by both the subject/owner (recording server) and by the
party that verifies the certificate (management server)

© The CA certificate must be trusted on the management server. In this way the management server can verify
the validity of the certificates issued by the CA

© The CA certificate is used to establish secure connection between the recording servers and the management
server

O The CA certificate must be installed on the computers on which the recording servers are running
Requirements for the private recording server certificate:

« Issuedto the recording server so that the recording server's host name is included in the certificate, either
as subject (owner) or in the list of DNS names that the certificate is issued to

« Trusted on the management server, by trusting the CA certificate that was used to issue the recording
server certificate
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Encryption to clients and servers that retrieve data from the
recording server (explained)

When you enable encryption on a recording server, communication to all clients, servers, and integrations that
retrieve data streams from the recording server are encrypted. In this document referred to as 'clients".

« XProtect Smart Client

« Management Client

« Management Server (for System Monitor and for images and AVI video clips in email notifications)
« XProtect Mobile Server

« XProtect Event Server

« XProtect LPR

« ONVIF Bridge

« XProtect DLNA Server

« Sites that retrieve data streams from the recording server through Milestone Interconnect

« Some third-party MIP SDK integrations

For solutions built with MIP SDK 2018 R3 or earlier that accesses recording servers: If the

A integrations are made using MIP SDK libraries, they need to be rebuilt with MIP SDK 2019
R1; if the integrations communicate directly with the Recording Server APIs without using
MIP SDK libraries, the integrators must add HTTPS support themselves.

Certificate distribution

The graphic illustrates the basic concept of how certificates are signed, trusted, and distributed in XProtect VMS to
secure the communication to the recording server.

12 | Secure communication (explained)



Certificates guide | XProtect® VMS 2019 R2

ik =-i§j
Ol

© A CA certificate acts as a trusted third-party, trusted by both the subject/owner (recording server) and by the

party that verifies the certificate (all clients)

© The CA certificate must be trusted on all clients. In this way the clients can verify the validity of the certificates
issued by the CA

© The CA certificate is used to establish secure connection between the recording servers and all clients and

services
© The CA certificate must be installed on the computers on which the recording servers are running
Requirements for the private recording server certificate:

« Issuedto the recording server so that the recording server's host name is included in the certificate, either
as subject (owner) or in the list of DNS names that the certificate is issued to

« Trusted on all computers running services that retrieve data streams from the recording servers, by
trusting the CA certificate that was used to issue the recording server certificate

« The service account that runs the recording server must have access to the private key of the certificate on
the recording server.

If you enable encryption on the recording servers and your system applies failover
recording servers, Milestone recommends that you also prepare the failover recording
servers for encryption.
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Mobile server data encryption (explained)

In XProtect VMS, encryption is enabled or disabled per mobile server. When you enable encryption on a mobile
server, you will have the option to use encrypted communication with all clients, services, and integrations that
retrieve data streams.

Certificate distribution for mobile servers

The graphic illustrates the basic concept of how certificates are signed, trusted, and distributed in XProtect VMS to
secure the communication with the mobile server.

© A CA certificate acts as a trusted third party, trusted by both the subject/owner (mobile server) and by the party
that verifies the certificate (all clients)

© The CA certificate must be trusted on all clients. In this way clients can verify the validity of the certificates
issued by the CA

© The CA certificate is used to establish secure connection between the mobile server and clients and services
O The CA certificate must be installed on the computer on which the mobile server is running
Requirements for the CA certificate:

« The mobile server's host name must be included in the certificate, either as subject/owner or in the list of
DNS names that the certificate is issued to

« The certificate must be trusted on all devices that are running services that retrieve data streams from the
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mobile server

« The service account that runs the mobile server must have access to the private key of the CA certificate
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Creating and distributing certificates manually

Creating and distributing certificates manually is NOT recommended as a secure way of

A distributing certificates. If you choose manual distribution, you are responsible for keeping
the private certificates secure at all times. When you keep the private certificates secure,
the client computers that trust the certificates are less vulnerable to attacks.

Create CA certificate

On a computer with restricted access and not connected to your XProtect system, run this script once to create a
CA certificate.

The computer that you use for creating certificates must run Window 10 or Windows
Server OS 2016 or newer.

This script creates two certificates:

« Aprivate certificate - only exists in the Personal Certificates store for the current user after the script is
run and should never leave the computer that you created the certificate on

« Apublic certificate - to be imported as trusted certificate on all client computers
1. In Appendix A, in the back of this guide, you find a script for creating the CA certificate. Copy the content.

2. Open Notepad and paste the content.

Itis very important that the lines break in the same places as in Appendix A. You can
add the line breaks in Notepad or alternatively, reopen this PDF with Google
Chrome, copy the content again and paste it into Notepad.

3 CreateCACertificate.ps1 - Notepad =c
File Edit Format View Help

# Run this script once, to create a certificate that can sign multiple recording server certificates

# Private certificate for signing other certificates (in certificate store)

$ca_certificate = New-SelfSignedCertificate -CertStorelocation cert:\CurrentUser\My -DnsName 'VMS Certificate Authority' -KeyusageProperty All ~
-KeylUsage CertSign, CRLSign, DigitalSignature -FriendlyName ‘VMS CA Certificate’

# Thumbprint of private certificate used for signing other certificates

Set-Content -Path "$PSScriptRoot\ca_thumbprint.txt” -Value $ca_certificate.Thumbprint

# Public CA certificate to trust (Third-Party Root Certification Authorities)

Export-Certificate -Cert "Cert:\CurrentUser\My\$($ca_certificate.Thumbprint)"” -FilePath "$PSScriptRoot\root-authority-public.cer’|

< >
Lng, Col 130

3. InNotepad, click File -> Save as, name the file CreateCACertificate.ps1 and save it locally, like this:
C\Certificates\CreateCACertificate.ps1.

4. In File Explorer, go to C\Certificates and select the CreateCACertificate.ps1 file.
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5. In the File menu, select Open Windows Powershell and then Open Windows PowerShell as
administrator.

TF Cert
; ) T “Jopen ~  HH select an
Open new window L2 "uu' Open Windows PowerShell ’ .J e
¥ Dot Select none
Properties ’a et ot
¢ 5, - istory nvert selection
B Open command prompt > ,@« Open Windows PowerShell as administrator v |
Lr 2 5

ﬂ Open Windows PowerShell | »

Date modified Type Size
@;(4' Delete history L3
File folder
e File folder
Help »
File folder
L File folder
e 4
ot File folder
File folder
|8 CreateCACertificate.ps] Windows PowerShell Script 1KB
18 This PC

B neooaoo

6. In PowerShell at the prompt, enter .\CreateCACertificate.ps1 and press Enter.

EN Administrator: Windows PowerShell - [m] X

CreateCACertificate.psl
Certificates

h Name

7. Check that the root-authority-public.cer file appears in the folder where you ran the script.

Your computer may require that you change the PowerShell execution policy. If yes,
enter Set-ExecutionPolicy RemoteSigned. Press Enter and select A,

Install certificates on the clients

After you created the CA certificate, you trust the public CA certificate by installing it on all the computers that act
as clients to the service according to the descriptions and graphics in the section on Secure communication
(explained) on page 9. In this section referred to as clients.

1. Copy the root-authority-public.cer file from the computer where you created the CA certificate
(C\Certificates\root-authority-public.cer) to the computer where the client is installed.

n For information about which client and server services, and integrations that require
the certificate, see Introduction to certificates on page 6.

17 | Creating and distributing certificates manually



Certificates guide | XProtect® VMS 2019 R2

2. Right-click on the certificate and select Install Certificate.

Open

Install Certificate

Edit with Notepad++

Scan with Windows Defender...
Share

Open with...

Give access to

Restore previous versions

Send to

Cut
Copy

Create shortcut
Delete

Rename

Properties

3. Inthe Certificate Import Wizard, select to install the certificate in the store of the Local Machine and click
Next.

o* Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

Store Location

() Current User

To continue, dick Next,

| et | | Cancel
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4. Select to manually locate the store in which the certificate will be installed.

€ =¥ Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specfy a location for
the certificate.

() Automatically select the certificate store based on the type of certificate

‘ (®2lace all certificates in the following store:

Certificate store:

| Browse...

5. Click Browse, select Trusted Root Certification Authorities and click OK. Then click Next.

Select Certificate Store X

Select the certificate store you want to use,

~{__| Personal A
Bg Trusted Root Certification Authorities
i1 | Enterprise Trust

| Intermediate Certification Authorities

| Trusted Publishers
1o 1l intrnsted Certifirates

[]show physical stores

6. Onthe Completing the Certificate Import Wizard dialog, click Finish.
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If you receive a security warning that you are about to install a root certificate, click
- Yes to continue.

€ & Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have spedified the following settings:

o= (or= 1= o] =gl = =i =s e A =@ Trusted Root Certification Authorities
Content Certificate

7. You will receive a confirmation dialog of successful import.

Certificate Import Wizard o

o The import was successful,
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8. To verify that the certificate is imported, start the Microsoft Management Console.

& Run

= Typethe name of a prograr, folder, document, or Internet
resource, and Windows will open it for you,

Pt

Open: | rnrncl

Cancel | | Browse...

9. Inthe Microsoft Management Console, from the File menu select Add/Remove Snap-in....

[& Console! - [Cansole Root]

File Action View Favorites Window Help

L] New Ctrl+N
= Open... Cirl+0
Save Cirl+S
Save As...
Add/Remove Snap-in... Cirl+M

Optiens..
Recent File

Exit

= X
- & X
Mame Actions
There are no items to show in this view. Sosole =
More Actions 4
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10. Select the Certificates snap-in and click Add.

Add or Remove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:

S Noridis ~ [l Console Root Edit Extensions...
- ‘-Acﬁvex Control Microsoft Car... o
[T Authorization Manager Microsoft Cor...
=] Certificates Microsoft Cor...

- Component Services  Microsoft Car... Mave Up
;g*ﬂomputer Managem Microsoft Cor...

.j.- Device Manager Microseft Car... Add > Mo Ol
e Disk Management Microsoft and... -

@ Event Viewer Microsoft Car...

~|Folder Microsoft Cor...

_EJ Group Policy Object ... Microsoft Cor...
t’_j Internet Informatio...  Microsoft Cor...
g Internet Informatio...  Microsoft Cor...
g IP Security Monitor Microsoft Cor... Advanced. ..

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

Cancel

11. Select that the snap-in must manage certificates for the Computer account.

Certificates snap-in *

This snap4n will always manage certificates for;

() My user account

() Service account

< Back Mext > Cancel
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12. Select Local computer as the computer that you want the snap-in to manage and click Finish.

Select Computer *

Select the computer you want this snap-n to manage.

This snap-n will always manage:

| (® Local computer: the computer this console is running onk

() Another computer: Browse...

[ Mllow the selected computer to be changed when launching from the command line. This
only applies f you save the console.

< Back Cancel

13. Click OK after the snap-in has been added.

Add or Remove Snap-ins

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
Snap-n Vendor ~ [] Console Root | Edit Extensions...
= ActiveX Control Microsoft Cor... Cal Certificates (Local Computer) SRR
Auﬂﬂorizaﬁon Manager Microsoft Cor.., -
B Certificates Microsoft Cor...
. Component Services  Microsoft Cor... Move Up

;QiComputer Managem Microsoft Cor...

A : i ] E
jiw Device Manager Microsoft Cor...

Move Down

o Disk Management Microsoft and. ..
@ Event Viewer Microsoft Cor...
| Folder Microsoft Cor...

_E_J' Group Policy Object ... Microsoft Cor...
f:' Internet Informatio...  Microsoft Cor...
E@Internet Informatio...  Microsoft Cor...
g IP Security Monitor Microsoft Cor... Advanced. ..

Description:

The Certificates snap-in allows you to browse the contents of the certificate stores for yourself, a service, or a computer.

oK Cancel
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14. Verify that the certificate is listed in the center view of the Trusted Root Certification Authorities subtree.

| Intermediate Certification Authorities
| Trusted Publishers
| Untrusted Certificates

5] Class 3 Public Primary Certificat..
S Copyright (c) 1957 Microsoft C..,

2l Microsoft Root Certificate Auth...
S IMicrosoft Root Certificate Auth...
S Microsoft Root Certificate Auth...

S Milestone Mobile

[INO LIABILITY ACCEPTED, ()97 ...
[l Starfield Class 2 Certification A...

[5]5tarfield Services Root Certificat...
(5] Symantec Enterprise Mobile Ro...
<

Class 3 Public Primary Certificatio.. 20
Copyright (c) 1997 Microsoft Corp. 19

| Third-Party Raat Certification Authorities 51 DigiCert Assured ID Root CA DigiCert Assured ID Root CA 203
= Trusted People 5] DigiCert Global Root CA DigiCert Global Root CA 20
B Chent Authentication lssusers 551 DigiCert High Assurance EV Ro... DigiCert High Assurance EV Root 200
| Preview Build Roots 51DST Root CA X3 DST Root CAX3 20;
| AAD Token Issuer [ Equifax Secure Certificate Auth... Equifax Secure Certificate Authority 207
| &5IM Certification Autharities 51 GeoTrust Global CA GeoTrust Global CA 20:
| Homegroup Machine Certificates [=;1GlobalSign GlobalSign 20;
“] Remote Desktop 5] GlobalSign GlobalSign 20i
.| Certificate Enrollment Requests 5] GlobalSign Root CA GlobalSign Root CA 200
=] Smart Card Trusted Roots [51Go Daddy Class 2 Certification ... Go Daddy Class 2 Certification Au... 20;
3 Trusted Devices 51 GTE CyberTrust Global Root GTE CyberTrust Global Root 20
il Web Hasting lHotspot 2.0 Trust Root CA- 03 Hotspot 2.0 Trust Root CA - 03 20
M Windows L |Djloken lestse C;Microsoft Authenticode(tm) Ro... Microsoft Authenticode(tm]) Root... 20(

[SIMicrosoft Root Authority Microsoft Root Autherity 20¢

Microsoft Root Certificate Authori
Microsoft Root Certificate Authari...
Microsoft Root Certificate Authori...
Milestone Mobile
MO LIABILITY ACCEPTED, ()97 Ve... 20
Starfield Class 2 Certification Auth... 20¢
Starfield Services Root Certificate .. 202
Symantec Enterprise Mobile Root ... 200 ¥
>

Trusted Root Certification Authorities store contains 34 certificates.

& Consolel - [Console Root\Certificates (Local Computer)\Trusted Raat Certification Authorities\Certificates] = u] X
Eile Action View Favorites Window Help -8 x
e nm 8 6= B
I Cowole Hork Issued To Issued By Ext ™ || Actions
~ [}l Certificates (Lacal Computer) £1105.1440 s o || -
_ Personal Ca |
= £1105.6.101 10.5.6.101 20¢
| Trusted Root Certification Authorit st More Actions 4
Mo _'“:Mmt g MR T 53] AddTrust External CA Root AddTrust External CA Root 200
| Certificates e |
- [5lBaltimore CyberTrust Root Baltimore CyberTrust Root 20;
__ Enterprise Trust Elckms o .

15. Repeat the steps on the next computer that runs as a client to the service where encryption is being
enabled, until you have installed the certificate on all relevant computers.

Create SSL certificate

After you have installed the CA certificate on all the clients, you are ready to create certificates to be installed on all
computers that run servers (recording servers, management servers, mobile servers or failover servers).

On the computer where you created the CA certificate, from the folder where you placed the CA certificate, run
the Server certificate script to create SSL certificates for all servers.

The computer that you use for creating certificates must run Window 10 or Windows
Server 2016 or newer.

1. In Appendix B in the back of this guide, you find a script for creating server certificates.
2. Open Notepad and paste the contents.

Itis very important that the lines break in the same places as in Appendix B. You can
add the line breaks in Notepad or alternatively, reopen this PDF with Google
Chrome, copy the contents again and paste it into Notepad.
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3. InNotepad, click File -> Save as, name the file CreateServerCertificate.ps1 and save it locally in the same
folder as the CA certificate, like this:
C\Certificates\CreateServerCertificate.ps1.

4. In File Explorer, go to C:\Certificates and select the CreateServerCertificate.ps1 file.

5. Inthe File menu, select Open Windows Powershell and then Open Windows PowerShell as
administrator.

[ ~ Jopen - HH setect an
Open new window k E‘ Open Windows PowerShell J dop e
i - [ Eart Select none
Properties B Hist K AR
ch_ 3 = b History nvert selection
B Open command prompt % Open Windows PowerShell as administrator : =
4Ll g

"u‘ Open Windows PowerShell | ¥

ﬂ— Date modified Type Size
; Delete history L4
v 04-02-201911:31 File folder
e 911:31 File folder
Help L3
04- 911:31 File folder
(e 0d- 911:31 File folder
» Close a a £a
04- 911:53 File folder
04- 911:31 File folder
|y CreateCACertificate.psl 31-01- 01 Windows PowerShell Script 1KB
18 This PC |5y CreateServerCertificate.ps1 25-01-20 31 Windows PowerShell Script 3KB
= Decltnn

6. In PowerShell at the prompt, enter \CreateServerCertificate.ps1 and press Enter.

7. Enter the DNS name for the server. If the server has multiple names, for example for internal and external
use, add them here, separated by a space. Press Enter.

To find the DNS name, open File explorer on the computer running the Recording
Server service. Right-click This PC and select Properties. Use the Full computer
name.

EX sdmministeatar Windowd PoweShall = =] X

8. Enter the IP address of the server. If the server has multiple IP addresses, for example for internal and
external use, add them here, separated by a space. Press Enter.

To find the IP address, you can open Command Prompt on the computer running
the Recording Server service. Enter ipconfig /all. If you have installed the XProtect

0 system, you can open the Management Client, navigate to the server and find the IP
address on the Info tab.

9. Specify a password for the certificate and press Enter to finish the creation.
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| You use this password when you import the certificate on the server.

A Subjectname.pfx file appears in the folder where you ran the script.

10. Runthe script until you have certificates for all of your servers.

Import SSL certificate

After you created the SSL certificates, install them on the computers that run the server service.

1. Copy the relevant Subjectname.pfx file from the computer where you created the certificate to the
corresponding server service computer.

| Remember that each certificate is created to a specific server.

2. Onthe server service computer, start Manage computer certificates.
3. Click on Personal, right-click Certificates and select All Tasks > Import.
certlm - [Certificates - Local Computer] o=
File Action Wiew Help

= |5 c= B

— Cerificates - Local Computer | Logical Store Mame

4 || Personal

|| Certificates
ﬂ Trusted Root Certification Authorities
| Enterprise Trust

| Personal
| Trusted Root Certification Authorities
| Enterprise Trust

> .
| Intermediate Certification Authorities

| Trusted Publishers
| Untrusted Certificates

Intermediate Certification Authorities
Trusted Publishers

Untrusted Certificates 2
Third-Party Root Certification Authorities || Third-Party Root Certification Authorities
| Trusted People

|
[
E
il
e
[ [ ] Trusted People
[ || Client Authentication |ssuers | Client Authentication lssuers
» | Homegroup Machine Certificates | Homegroup Machine Certificates
- || MSIEHistorylournal | MsIEHistorylournal
i [ OfcEdge | OfcEdge
[ || OfficeScan SSL Agent | OfficeScan 551 Agent
[ [ | Remote Desktop _ Remote Desktop
s [ Smart Card Trusted Roots | Smart Card Trusted Roots
i [ | Trusted Devices | Trusted Devices
[ [ Web Hosting 15 Web Hosting

= || Windows Live ID Token Issuer = Windows Live ID Token lssuer

< >
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4. Select toimport the certificate in the store of the Local Machine and click Next.

&% Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps yvou copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store,

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure netwark
connections, A certificate store is the system area where certificates are kept.

Store Location

O Current User

To continue, dick Next.

| Oet | | Cancel

27| Creating and distributing certificates manually



Certificates guide | XProtect® VMS 2019 R2

5. Browse to the certificate file and click Next.

(€ £ Certificate Import Wizard

File to Import
Spedify the file you want to import.

File name:

Received Files\WMS-REC-0 L.phx | | TR

Mote: Mare than one certificate can be stored in a single file in the following formats:
Personal Information Exchange- PKCS £12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS #7 Certificates (\P7EB)

Microsoft Serialized Certificate Store (L55T)

Mesxt || Cancel !
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6. Enter the password for the private key that you specified when you created the server certificate, and click
Next.

(€) £ Certificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password,

Type the password for the private key.

Password:

[ ] Display Passward

Import options:

[ ]Enable strong private key protection. You will be prompted every time the
private key is used by an application if you enable this option,

[ Mark this key as exportable. This will allow you to back up or transpart your
keys at a later time.

Indude all extended properties.

_. Cancel
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7. Place the file in the Certificate Store: Personal and click Next.

(€) £ Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate,

i) Automatically select the certificate store based on the type of certificate
(®) Place all certificates in the following store

Certificate store:

Personal Browse. ..

Cancel
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8. Verify the information and click Finish to import the certificate.

(€) £ Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imparted after you dick Finish.

You have spedfied the following settings:

Certificate Store Selected by User Personal

Content PFX

File Mame C:\Users'gis\Desktop\WMS-REC-01.pfx

Finish Cancel

9. The imported certificate appears in the list.

31 | Creating and distributing certificates manually



Certificates guide | XProtect® VMS 2019 R2

= certlm - [Certificates - Local Computer\Personal\Certificates] =:E
File Action View Help

e | sFa|c=HE

5 Certificates - Local Computer lssued To 2 Issued By
a [ ]| Personal 1 * milestonesys.local MILESTONECA

ification Authoriti *.milestonesys.local MILESTOMNECA
rusted Root Certification Authorities
d ?ﬁ*.milestonesys.wdev MILESTONECA
Ent Trust

Inr;:ei::rel:?at:(:ertification Authorities @ tasalliest iraliet

Trusted Publishers LI VMS Certificate Authority VS Certificate Authority
Unitrusted Certificates ?ﬁVMS—REC-O'I VMS Certificate Authority I
Third-Party Root Certification Authorities
Trusted Pecple

Client Authentication Issuers
Homegroup Machine Certificates
MSIEHisteryJournal

OfcEdge

OfficeScan 551 Agent

Remote Desktop

Smart Card Trusted Roots

> [ Trusted Devices

p [ Web Hosting

> [ Windows Live ID Token Issuer

DERERERERRR R R &

10. To allow a service to use the private key of the certificate, right click the certificate and select All Tasks >
Manage Private Keys.

Open

All Tasks - Open

Cut Request Certificate with New Key..

Copy Renew Certificate with New Key..

— Manage Private Keys...

Properties Advanced Operations ;
Help Export..
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11. Add read permission for the service user for the service that needs to use the server certificate.

Permissions >

Security

Group or user names:

£R SYSTEM
£2 Administrators {Administrators)

NETWORK SERVICE

Add... Remove
Pemissions for NETWORK
SERVICE Allow Deny
Full control | |
Read | |
Special permissions
For special pemmissions or advanced settings, Ahrarcad

click Advanced.

12. Continue to the next computer, until you have installed all server certificates.
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Enable encryption

You are ready to apply encryption in your system either during installation of XProtect VMS or by enabling
encryption via the server tray icon.

See the following methods:
« Enable encryption to clients and servers on page 34
« Enable encryption to the management server on page 36
« Enable encryption from the management server on page 37

« Enable encryption on the mobile server on page 39

Enable encryption to clients and servers

You can encrypt connections from the recording server to clients and servers that stream data from the recording
server. For more information, see Secure communication (explained).

Requirements:

« Aserver authentication certificate is trusted on all computers running services that retrieve data streams
from the recording server

« XProtect Smart Client and all services that retrieve data streams from the recording server must be
upgraded to version 2019 R1 or later

« Some third-party solutions created using MIP SDK versions earlier than 2019 R1 may need to be updated

1. Onthe computer that runs the recording server, right-click the Recording Server Manager icon in the
notification area.

2. Select Stop Recording Server service.
3. Right-click the Recording Server Manager icon again and select Change Settings.
The Recording Server Settings window appears.

4. At the bottom, specify encryption settings for the recording server:
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& Recording Server Settings ot
—Management Server

Address: |Iucalhust

Port: {9000

—Recording server

\wieh server port: |T-"563
Alert server port: |5432
SMTF server
[~ Enabled
Paort: 25
—Encryption

™ Use one configuration for all servers

= Configure servers individually

[T Encrypt connections from the management server to the recording server

|<Nu cerificate selected> | Details... |

ol Encrypt connections from clients and servers that retnieve data streams from the recording
Server

|<Nu cerificate selected | Details... |

ok | cancel |

« Encrypt connections from clients and servers that retrieve data streams from the recording
server: Before you enable encryption, read the requirements listed in this topic

« Select a certificate: Contains a list of unique subject names of certificates installed on the local
computer in the Windows Certificate Store that has a private key.

The recording server service user has been given access to the private key. It is required that this
certificate is trusted on all clients.

« Details: Click to view Windows Certificate Store information about the selected certificate
5. Click OK.

6. To start the Recording Server service again, right-click the Recording Server icon and select Start
Recording Server service.
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n Stopping the Recording Server service means that you cannot record and view live video
while you are verifying or changing the recording server's basic configuration.

To verify if the recording server uses encryption, see View encryption status to clients on page 41.

Enable encryption to the management server

You can encrypt the two-way connection between the management server and the recording server. If your
system contains multiple recording servers, you must enable encryption on all the recording servers. For more
information, see Secure communication (explained).

Requirements:

« Aserver authentication certificate is trusted on all recording servers
« All recording servers must be upgraded to version 2019 R1 or later
First you enable encryption on the management server.
Steps:

1. Onthe computer that runs the management server, right-click the Management Server Manager icon in the
notification area.

2. Select Management Server service.
3. Right-click the Management Server Manager icon again and select Change encryption settings.
The Management server encryption settings window appears.

4. Specifyencryptionsettingsfortherecordingserver:

%" Managerment server encryption settings X

Encryption settings

Encrypt connections from the recording servers to the management server

|<ND certificate selected:

Cancel

« Encrypt connections from the recording servers to the management server: Before you enable
encryption, read the requirements listed in this topic

« Select a certificate: Contains a list of unique subject names of certificates installed on the local
computer in the Windows Certificate Store that has a private key, and the CA certificate must be
trusted on the management server.

« Details: Click to view Windows Certificate Store information about the selected certificate
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5. (lick OK.

6. To start the Management Server service again, right-click the Management Server Manager icon and select
Start Management Server service.

To complete the enabling of encryption, next step is to update the encryption settings on each recording server.
For more information, see Enable encryption from the management server on page 37.

Enable encryption from the management server

You can encrypt the two-way connection between the management server and the recording server. If your
system contains multiple recording servers, you must enable encryption on all the recording servers. For more
information, see Secure communication (explained).

Requirements:

« Aserver authentication certificate is trusted on the management server
« Allrecording servers must be upgraded to version 2019 R1 or later

« You have enabled encryption on the management server, see Enable encryption to the management
server on page 36

1. Onthe computer that runs the recording server, right-click the Recording Server Manager icon in the
notification area.

2. Select Stop Recording Server service.
3. Right-click the Recording Server Manager icon again and select Change Settings.
The Recording Server Settings window appears.

4. At the bottom, specify encryption settings for the recording server:
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& Recording Server Settings ot
—Management Server

Address: |Iucalhust

Port: {9000

—Recording server

\wieh server port: |T-"563
Alert server port: |5432
SMTF server
[~ Enabled
Paort: 25
—Encryption

™ Use one configuration for all servers

= Configure servers individually

[¥ Encrypt connections from the management senver to the recording server

|<Nu cerificate selected> | Details.. |

= Encrypt connections from clients and servers that retnieve data streams from the recording
Server

|<Nu cerificate selected | Details... |

ok | cancel |

« Encrypt connections from the management server to the recording server: Before you enable
encryption, read the requirements listed in this topic

« You can select the Use one configuration for all server option, if you use the same certificate on all
the servers.

« Select a certificate: Contains a list of unique subject names of certificates installed on the local
computer in the Windows Certificate Store that has a private key.

« Details: Click to view Windows Certificate Store information about the selected certificate
5. Click OK.

6. Inthe Register on the management server dialog box, enter the address of the management server that
you want the recording server to connect to and click OK. Default port number is 443.

7. Enter the user name and password of a system administrator of XProtect and click OK.
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8. To start the Recording Server service again, right-click the Recording Server icon and select Start
Recording Server service.

n Stopping the Recording Server service means that you cannot record and view live video
while you are verifying or changing the recording server's basic configuration.

Enable encryption on the mobile server

To use an HTTPS protocol for establishing secure connection between the mobile server and clients and services,

you must apply a valid certificate on the server. The certificate confirms that the certificate holder is authorized to

establish secure connections. For more information, see Mobile server data encryption (explained) on page 14 and
Mobile server encryption requirements for clients.

Certificates issued by CA (Certificate Authority) have a chain of certificates and on the root
of that chain is the CA root certificate. When a device or browser sees this certificate, it
compares its root certificate with pre-installed ones on the OS (Android, iOS, Windows,
etc.). If the root certificate is listed in the pre-installed certificates list, then the OS ensures
the user that the connection to the server is secure enough. These certificates are issued
for adomain name and are not free of charge.

To enable encryption, after the mobile server has been installed:

1. Onacomputer with a mobile server installed, right-click the Mobile Server Manager tray icon in the taskbar
of the operating system and select Edit certificate.

2. Select the Encrypt the connections for clients and services that retrieve data streams from the mobile
server check box.
3. Toselect avalid certificate, click *** Awindows Security dialog box opens.

4. Select the certificate that you want to apply.

5. (lick OK.

Edit certificate

If the certificate that you use for secure connection has expired, you can select another certificate that is installed
on the computer on which the mobile server is running.

To change a certificate:

1. Onacomputer with a mobile server installed, right-click the Mobile Server Manager tray icon in the taskbar
of the operating system and select Edit certificate.

2. Toselect avalid certificate, click *** Awindows Security dialog box opens.
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3. Select the certificate that you want to apply.

4. Click OK.

A message informs you that the certificate has been installed and that the Mobile Server service has been
restarted to apply the change.
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View encryption status to clients

To verify if your recording server encrypt connections:
1. Open the Management Client.
2. Inthe Site Navigation pane, select Servers > Recording Servers. This opens a list of recording servers.

3. Inthe Overview pane, select the relevant recording server and go to the Info tab.
If encryption is enabled to clients and servers that retrieve data streams from the recording server, a
padlock icon appears in front of the local web server address and the optional web server address.

Recording server information

Mame:
|Hecording server 1 |
Description:
Covers sector 1 ~
L
Host name:

e |
Local web server address:
| @ hitps://m——— e —— 7563/ |

Web server address:
|i hittps:/www recordingserver] dic: 29/ |

Time zone:
|(UTC+01:00) Brussels, Copenhagen, Madrid, Paris |

€ o | [ Storage | ] Failover | Multicast | % Network |
| ——
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View encryption status on a failover recording server

To verify if your failover recording server uses encryption, do the following:

1. Inthe Site Navigation pane, select Servers > Failover Servers. This opens a list of failover recording
servers.

2. Inthe Overview pane, select the relevant recording server and go to the Info tab.
If encryption is enabled to clients and servers that retrieve data streams from the recording server, a
padlock icon appears in front of the local web server address and the optional web server address.

Properbes

Failowver server information

Mame:

|FEIi|D'u'E:r recording server 1|

Description:

Failover for Recording server 1

Host name:

- e local |

Local web server address:
|i hitpe:/ . local: 7563/ |

Web server address:

| @ https:/ Awww failoverecordingserver] -89/ |
UDP port:

Database location:
|E':"'LI'U'|edia Database

Enable this failover server

€D Info 5T Network b Multicast
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Appendix A | Create CA Certificate script

# Run this script once, to create a certificate that can sign multiple server SSL certificates

# Private certificate for signing other certificates (in certificate store)
$ca_certificate = New-SelfSignedCertificate -CertStoreLocation cert:\CurrentUser\My -DnsName 'VMS Certificate Authority' -KeyusageProperty All °
-KeyUsage CertSign, CRLSign, DigitalSignature -FriendlyName 'VMS CA Certificate’

# Thumbprint of private certificate used for signing other certificates
Set-Content -Path "$PSScriptRoot\ca_thumbprint.txt" -Value $ca_certificate.Thumbprint

# Public CA certificate to trust (Third-Party Root Certification Authorities)
Export-Certificate -Cert "Cert:\CurrentUser\My\$($ca certificate.Thumbprint)" -FilePath "$PSScriptRoot\root-authority-public.cer"



Appendix B | Create Server SSL Certificate script

# Run this script once for each server for which an SSL certificate is needed.

# Certificate should be executed on the single computer where the CA certificate is located.
# The created server SSL certificate should then be moved to the server and imported in the
# certificate store there.

# After importing the certificate, allow access to the private key of the certificate for

# the service user(s) of the services that must use the certificate.

# Load CA certificate from store (thumbprint must be in ca_thumbprint.txt)

$ca_thumbprint = Get-Content -Path "$PSScriptRoot\ca_ thumbprint.txt"

$ca_certificate = (Get-ChildItem -Path cert:\CurrentUser\My\$ca_thumbprint)

# Prompt user for DNS names to include in certificate
$dnsNames = Read-Host 'DNS names for server SSL certificate (delimited by space - 1st entry is also subject of certificate)’
$dnsNamesArray = @($dnsNames -Split ' ' | foreach { $_.Trim() } | where { $_})

if ($dnsNamesArray.Length -eq 0) {
Write-Host -ForegroundColor Red 'At least one dns name should be specified'’
exit

}

$subjectName = $dnsNamesArray[Q]

$dnsEntries = ($dnsNamesArray | foreach { "DNS=$_" }) -Join '&'

# Optionally allow the user to type in a list of IP addresses to put in the certificate
$ipAddresses = Read-Host 'IP addresses for server SSL certificate (delemited by space)'’
$ipAddressesArray = @($ipAddresses -Split ' ' | foreach { $_.Trim() } | where { $_ })
if ($ipAddressesArray.Length -gt 9) {

$ipEntries = ($ipAddressesArray | foreach { "IPAddress=$ " }) -Join '&'

$dnskEntries = "$dnsEntries&$ipEntries”

# Build final dns entries string (e.g. "2.5.29.17={text}DNS=myhost&DNS=myhost.domain.com&IPAddress=10.0.0.103")
$dnsEntries = "2.5.29.17={text}$dnsEntries”

# The only required purpose of the sertificate is "Server Authentication”
$serverAuthentication = '2.5.29.37={critical}{text}1.3.6.1.5.5.7.3.1"

# Now - create the server SSL certificate
$certificate = New-SelfSignedCertificate -CertStoreLocation Cert:\CurrentUser\My -Subject $subjectName -Signer $ca_certificate °
-FriendlyName 'VMS SSL Certificate' -TextExtension @($dnsEntries, $serverAuthentication)

# Export certificate to disk - protect with a password
$password = Read-Host -AsSecureString "Server SSL certificate password"
Export-PfxCertificate -Cert "Cert:\CurrentUser\My\$($certificate.Thumbprint)" -FilePath "$PSScriptRoot\$subjectName.pfx" -Password $password

# Delete the server SSL certificate from the local certificate store
$certificate | Remove-Item
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About Milestone

Milestone Systems is a leading provider of open platform video management software; technology that helps
the world see how to ensure safety, protect assets and increase business efficiency. Milestone Systems
enables an open platform community that drives collaboration and innovation in the development and use of
network video technology, with reliable and scalable solutions that are proven in more than 150,000 sites
worldwide. Founded in 1998, Milestone Systems is a stand-alone company in the Canon Group. For more
information, visit https://www.milestonesys.com/.
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